
Chapter One: Getting Started

What is Mangia ?
Mangia is an easy and fun way to store, retrieve and organize recipes. Once you have a collection
of recipes stored in Mangia, you can easily create meals, make shopping lists, maintain your
pantry inventory, and even print menus for that fancy dinner party!

How to Read this Manual
Before you begin using Mangia, you should be aware of the writing conventions we used in this
manual.

♦ Lists of information are bulleted like this.

☛ Actual instructions that you should follow are marked with this hand.

When we refer to components of Mangia, like the Dictionary or the Recipe Browser, their names
will be capitalized. The names of menus, keys and buttons will all appear in Bold type. You will
sometimes see the shorthand File:Print , which means “Choose the Print option from the File
menu”.

When you must type something exactly as specified in the instructions, it will be shown in this
typeface . When you are required to provide your own information, it will be indicated like
this: <your name here> .

We will frequently refer to Shift-select or Ctrl -select when instructing you to choose recipes.
This means that you should hold down the Shift or the Ctrl key while clicking the mouse button
while the cursor is over the desired location.

The term “drag and drop” is often used when describing how to move items from one location to
another. To “drag” an item, click on it and hold down the mouse button while moving the cursor
to the desired location. “Drop” the object by releasing the mouse button.

Installing and Running Mangia

Windows 95
☛ Insert the Mangia CD into the appropriate drive.
☛ If the Autoplay feature of Windows 95 is enabled, a window will appear on your screen.

Click on the Install  button to begin the installation. Follow the onscreen instructions to com-
plete the installation.

☛ If Autoplay is disabled, and no window appears, open the My Computer icon on your desk-
top, double click on your CD drive, then double click on the “Setup” icon to begin the instal-
lation process. Follow the onscreen instructions to complete the installation.

☛ To run Mangia after installation, click on the Start button, select Programs, Sierra, then
select Mangia.



Windows 3.1
☛ Insert the Mangia CD into the appropriate drive.
☛ In Program Manager, select File:Run, then type d:\setup  and press Enter. (If your CD-

ROM drive is not drive D:, substitute the appropriate drive letter.)
☛ To run Mangia after installation, double click the Sierra group, then double click on the

Mangia icon.

Macintosh
☛ Insert the Mangia CD into the appropriate drive.
☛ Double-click the Install Mangia icon.
☛ In the resulting dialogue box, click Install .
☛ To run Mangia after installation, double click on the Mangia icon.

NOTE: When you run Mangia for the first time, the Recipe Browser will be empty. To load
recipes into the Recipe Browser, choose File:Open and select one of the Recipe Files that come
with Mangia. Chapter Two will show you how to create Recipe Files of your own.

How to Make a Demo Copy
Once your friends see you using Mangia, they will probably want to try it out! We have provided
an easy way to make a legal and free demo copy of Mangia for your fellow cooks. In the main
Mangia screen, select File:Make a Demo Copy, then choose the destination disk or folder from
the resulting dialog box. This demo copy is identical to your version of the program, with two
differences: it will only work for two months, and the Make a Demo Copy option is replaced by
Print Order Form .
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Chapter Two: Recipe Cards, Recipe Files and the
Recipe Browser

Recipes in Mangia are stored in Recipe Cards. A Recipe File is simply a collection of these
Recipe Cards, similar to a cookbook. Mangia comes with several Recipe Files already created.
The Recipe Browser is a list of recipes drawn from the Recipe Files and divided into categories.
This chapter will explain how to open these files and how to access the recipes within them.

The Recipe Browser
The Recipe Browser is Mangia’s main tool for organizing and managing your recipe collection.
Once you have recipes on file, you will use the Browser to:

♦ Add new recipes
♦ Find recipes
♦ Open recipes for viewing
♦ Sort recipes into categories

If the Recipe Browser does not appear when you start Mangia, you can access it by choosing
Tools:Recipe Browser. The Browser will be empty until you load a Recipe File into it.

☛ Click on the Pick Cookbook icon in the upper left corner of the Browser.
☛ In the resulting dialog box, you’ll see a list of the recipe files that come with Mangia. Click

on one to select it. A check mark will appear next to the selected file. (You can select more
than one cookbook if you want.)

☛ Click OK . The dialog box will disappear and you’ll see a list of recipes in the Browser.
☛ Click once on a recipe to highlight it. Notice the recipe’s description at the bottom of the

Browser window.

In this example, the recipes are organized by course. Note the tabs reading “dessert”, “entrees”,
etc. Click on a tab to see a list of the recipes in that category. In the bottom left of the recipe list,
you’ll see a small pop-up menu reading “Courses Dividers”. Click on this menu to change the
recipe categories.



Viewing a Recipe Card
The Recipe Browser shows you only recipe titles and descriptions. To view a recipe, click once
to highlight it, then click the View Recipe button. Or, double-click on a recipe’s title. This opens
the Recipe Card window, which shows the selected recipe in an appropriate layout.

Changing a Recipe’s Layout
Mangia can display recipes in many different layouts. The example above shows a recipe in the
“Classic Display” layout. To select a new layout, click on the pop-up Layout menu in the bottom
left of the Recipe Card window.

Printing a Recipe
You can print a recipe from either the Recipe Browser or the Recipe Card window.

☛ From the Recipe Card window, choose File:Print Recipe Card.
☛ From the Recipe Browser, click on the recipe you want to print and choose File:Print Reci-

pes. To highlight multiple recipes, hold down the Shift or Ctrl  while clicking.
☛ Choose the paper size and desired layout and click OK .

Chapter Six covers Mangia’s many printing options in detail.

Scaling a Recipe
If your recipe serves six, but you’re cooking for four, Mangia will adjust, or “scale” the ingredi-
ent amounts for you.

☛ Open the desired recipes, then select Recipe Card:Scale Amounts…
☛ In the resulting dialog box, specify how many people you want the recipe to serve, then click

OK .

NOTE: Mangia has no way to separate any amounts mentioned in the recipe’s instructions. For
example, part of the butter listed in the ingredient list in used in one step of the recipe and the
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remaining butter in another step. You will have to adjust each amount yourself when cooking the
recipe.

The Recipe Clipboard
While you’re browsing your recipe collection, you may find yourself wanting to “jot down”
recipes for later reference. Mangia provides a tool for just this purpose: the Recipe Clipboard.
You can use the Recipe Clipboard from either the Recipe Browser or the Recipe Card window.

☛ In the Recipe Browser, highlight the recipe or recipes that you want to send to the Recipe
Clipboard, then click on the Clipboard  (paper clip) icon.

☛ In the Recipe Card window, clicking on the Clipboard icon will send the recipe to the clip-
board.

☛ To view the Recipe Clipboard, double-click on the Clipboard  icon.
☛ To delete a recipe from the Clipboard, highlight the unwanted recipe and press the Delete

key.

Opening a Recipe File
Mangia stores your recipes in files on your hard drive, but how you organize your recipes into
these files is up to you. In the Recipe File window, you can rearrange, delete, and add new
recipes or group recipes into selected meals.

☛ If you are in the Recipe Browser, select Open or Quick Open from the File menu.
☛ Choose the recipe file you wish to open.
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In the example on the previous page, note the asterisk (*) next to the “Zabaglione” recipe. This
indicates that the recipe is not stored in this file, but is merely listed here as a reference to its
actual location in another file. Mangia allows you to create Recipe Files that are “collections” of
Recipe Cards from other Recipe Files, yet have only one copy of each Recipe Card on your hard
drive. This saves space by not duplicating files on your hard drive.

Rearranging a Recipe List
The order of recipes is very flexible; you can manually rearrange them, or Mangia can sort them
for you.

☛ To have Mangia sort your recipes in alphabetical order, choose Recipes:Sort by Title.
☛ If you have a collection of recipes taken from other sources like cookbooks or magazines,

you may want to sort your recipes by their source. Choose Sort by Source from the Recipes
menu and the recipes will appear in reference order. If the recipes are from a book, they are
listed by page-number; if from a magazine, they are listed by page number within each issue.

☛ To manually rearrange items, click on a meal or recipe to select it. Holding the mouse button
down, drag the recipe or meal to another location in the list and release the mouse button. The
selected item will move to its new location.

Creating a Meal
Many cookbooks include a list of suggested menus you can assemble from the dishes in the
book. Mangia does the same thing; you’ll see Mangia’s meals listed on the right side of the
Recipe File window.

☛ Shift-select the recipes you want to include in your meal.
☛ Click on the New Meal button in the upper right corner of the Recipe File window.
☛ A dialog box will ask you to provide the meal title. Enter a descriptive name, then click OK .

Your new meal will now appear in the meal list on the right side of the Recipe File menu.
☛ To edit the title or a recipe in an existing meal, double click on the item you wish to change.
☛ From an open recipe card, you can scale the recipes in your new meal by selecting Scale

Amounts from the Recipe Cards menu. Enter the new scale amounts, then click OK .
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You can also use the Recipe Clipboard to plan meals:

☛ From the Clipboard, Shift-click to select the desired recipes, then click on the New Meal
button. Type the name of your meal into the dialog box and click OK .

The selected recipes are grouped together under the title you entered to create your new meal.

☛ Simply click and drag a recipe to change its place in the meal.
☛ To scale all the recipes in your new meal at once, click on the meal title to highlight them,

then click on the Set Scale icon in the lower left corner.

Locating Recipes
If there is an asterisk next to a recipe in a recipe file list, that recipe is not actually located in that
recipe file; it is merely referenced from its original file. Therefore, if you wish to permanently
delete a recipe with an asterisk, you must open and delete its original recipe file. Fortunately,
Mangia provides you with a tool to find the original location of any recipe in your files.

☛ Select the title of a recipe in Recipe File.
☛ Choose Locate Recipe from the Recipes menu.

Mangia will open the original Recipe File window and highlight the desired recipe.

Deleting Recipes from Recipe Files
CAUTION: When you delete a recipe from a recipe file, Mangia permanently removes the recipe
from your hard drive.

☛ Open a Recipe File and highlight the unwanted recipe.
☛ Choose Delete from the Recipes menu.
☛ In the resulting dialog box, click OK to confirm the deletion or Cancel to back out.

Cloning and Copying Recipes
When entering several similar recipes, you may want to start a new recipe by making a copy of
an existing one.

☛ Select the title of a recipe in any Recipe File list.
☛ Choose Clone Recipes from the Recipes menu.

Mangia will make a copy of the original recipe, which you can change to fit your needs without
changing the original. Chapter Three covers changing recipes in detail.
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If you need a full copy of a recipe in a Recipe File (perhaps you wish to share a Recipe File with
another Mangia user),  you must use the Copy and Paste commands to duplicate the recipe:

☛ Open two recipe files. In one file, click on a recipe’s title to select it.
☛ From the Edit  menu, choose Copy.
☛ Click on the other recipe file window to bring it forward.
☛ From the Edit menu, choose Paste.

Mangia makes a complete copy of the selected recipe in the other file.
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Chapter Three: Adding and Changing Recipes

Adding a New Recipe
You can add a recipe to Mangia whenever a Recipe File window is open. For more information
on Recipe Files, see Chapter Two.

☛ Open a recipe file using File:Quick Open.
☛ Select Recipes:New Recipes or click on the New Recipe button.
☛ Type the name of the recipe, then click OK .

The Recipe Card opens up with the new recipe, and a window asking you to enter the title and
description of your new recipe.

☛ Enter a short description of your recipe. The contents of this field will now be displayed at the
bottom of the Recipe Browser whenever you highlight this recipe.

Using the Dictionary
While you are editing a recipe, you may see a small “hand and book” next to some of the text
boxes. This icon represents the Dictionary, one of Mangia’s most powerful tools. Mangia comes
with an extensive dictionary of food and cooking terms that make it easy to input information.

☛ From the Editing  pop-up menu, choose Course Served from the Categories menu. When
the cursor is in the Course Served field, the Dictionary  icon will highlight. Remove any
existing text in the field.

☛ Click on the Dictionary  button to see the resulting menu.

By navigating through the levels of this menu, you can find any appropriate entry in the Dictio-



nary. When you select an entry, Mangia will automatically insert it into the empty field.

Editing the Parts of the Recipe
There are eleven different parts of a recipe: the Title, Description, Source, Yield, Times, Ingredi-
ents, Notes, Instruction, Categories, Ratings and Compatible Recipes. The Recipe Editing win-
dow allows you to modify several parts at a time. There are five controls at the top of this
window:

♦ The left and right arrow buttons allow you to move forward and back through the editing
windows.

♦ The Editing pop-up menu lets you jump directly to the part of the recipe you wish to edit.
♦ The OK button saves and closes the recipe.
♦ The Save button saves your work without closing.

Recipes are not saved to your hard drive until you click the OK or Save button. If you wish to
exit without saving, click on the close box in the upper left corner of the editing window.

Entering the Recipe’s Ingredients
Most parts of a recipe are edited using standard text boxes and pop-up menus, but the Ingredients
list is an exception. This part of the recipe has a specialized structure that allows Mangia to
group recipes by their ingredients. The Ingredient list editor has two halves. On the left side you
describe an individual ingredient, and the ingredient list appears on the right.

☛ Create a new recipe, add its title and a short description, then jump to the Ingredients list
using the Editing pop-up menu.

☛ In the box labeled Amount, type 1 cup . In the Ingredient field, enter white wheat
flour , and sifted  into the Prep for Measuring field.

☛ Or, use the Dictionary  to select the amount, ingredient and prep.
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☛ Since this is a main ingredient in the new recipe, click the Main Ingredient  check box.
☛ Click Add to List . The ingredient is now in the list part of the window, and the text boxes are

empty, waiting for the next ingredient.
☛ Double-click on an ingredient in the list window to change it. This will move the ingredient

from the list window to the text boxes so that you can edit it. The Add to List  button will now
say Replace Selection. When you click on Replace Selection, the ingredient list will be
updated with your changes.

Using One Recipe as an Ingredient in Another
Many recipes use other recipes as ingredients. A salad, for example, may call for a particular
dressing. When this occurs, Mangia will let you use one recipe as an ingredient in another.
Suppose you’re creating a recipe for Crab Louis and its Ingredient List calls for Thousand Island
Dressing:

☛ Locate Thousand Island Dressing in the Recipe Browser. Click on it to highlight it, then
choose Edit:Copy .

☛ Go to the Ingredient List for Crab Louis and click in the Ingredient field. Choose Edit:Paste
or Ingredients:Use Recipe as Ingredient. “Thousand Island Dressing” will appear in the
Ingredient field.

☛ Click the Add to List  button to move “Thousand Island Dressing” to the ingredient list.

Now the dressing recipe is “linked” to the Crab Louis recipe and Mangia will include the ingre-
dients for the dressing in the Crab Louis recipe. For example, when you send Crab Louis to the
Shopping List, the list will also include all the ingredients necessary to make Thousand Island
Dressing. (We’ll cover the Shopping List in detail in Chapter Five.)

Grouping Ingredients in the Ingredient List
It is often helpful to create groups in an ingredient list. For example, in a pie recipe, you may
want to display the ingredients for the crust in a separate group from the filling ingredients.

☛ To move an ingredient, click on it, then drag it to another place on the list. You can move more
than one ingredient at a time by Shift-selecting each one.

☛ To group ingredients, Shift-click to select the items you want in the new group, then choose
Group from the Ingredients menu.

There are three types of groups to choose from:

☛ Either/Or  creates a Choice group, meaning that any one of the ingredients may be used, as
in “butter or margarine”.

☛ All  means that all ingredients in the group must be used.
☛ Named Group creates a named “section” in a recipe, like “Pie Crust” and “Cherry Filling”.
Once a group has been created, you can select the entire group by clicking at its left-hand side.
You can also click and drag ingredients into and out of the group.
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Merging Ingredients
Merging is useful when you want to say something like “1 lb. zucchini or yellow squash” instead
of using a Choice group with two ingredients with the same amounts: “1 lb. zucchini” or “1 lb.
yellow squash”.

☛ In the Ingredients list Shift-select the two ingredients you want to merge.
☛ Choose Merge into 1 Ingredient on the Ingredients menu.
☛ To switch back to two ingredients, highlight the merged ingredient and choose Separate

Ingredients from the Ingredients menu.
NOTE: If ingredient amounts differ, only the first amount is used.

You can also Merge ingredients when you enter them into the Ingredient Field. Simply type
yellow squash or zucchini  into the Ingredient field; the effect will be the same as
Merging them later.

Categorizing Recipes
When you click on the dividers in the Recipe Browser, you get recipes sorted into four catego-
ries: Course, Nationality, Cooking Method and Season.

☛ With a recipe open in the recipe editor, use the Editing  pop-up menu to select Categories, or
double-click on the Categories section of a recipe card.

☛ Click in the Nationality  field, then on the highlighted Dictionary button. A menu will ap-
pear.

☛ Click on an item in the menu to select it. Shift-select to choose more than one Nationality.

The Nationality field now shows your selection. The recipe will now be filed under both catego-
ries. You can also type into the text box without using the pop-up menu; multiple categories must
be separated with commas.

Rating a Recipe
Mangia lets you rate recipes for different attributes, such as “Spicy Hotness” and “Difficulty”.
These ratings are not only useful when browsing through your recipe collection, but you can also
use them to search for particular kinds of dishes in the Full Recipe Finder. (Chapter Four con-
tains detailed information on the Full Recipe Finder.)

☛ If you’re entering a new recipe, select Ratings from the Editing  pop-up menu. If you are
modifying an existing recipe, double-click on the Ratings section of the recipe to access the
Ratings window.

☛ Choose a Rating by clicking the Pick Rating button. You will get a menu that lets you access
the rating scales.

☛ Set the rating by clicking somewhere on the scale or dragging the indicator to the desired
location.

☛ To set a range, click and drag one of the “ears” on the sides of the indicator.
☛ Some ratings, like “Crock Pot” and “From the Garden”, use check boxes instead of sliding

scales. Simply click in the box to check it.
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Mangia provides several different rating scales, but you don’t have to use each one for every
recipe. When you’re entering or editing ratings, just use the ones you find relevant to that recipe.
You can also create your own rating scales by clicking on New Rating Scales… and entering the
new rating name and indicator type (either sliding scale or check box).

Locating Compatible Recipes
While browsing through Mangia’s cookbooks, you will often find recipes that go well together,
like “Salmon Croquettes” and “Aromatic Creole with Shrimp”. Mangia keeps track of these
compatible recipes for you.

☛ If you’re entering a new recipe, go to the Compatible Recipes list by selecting it from the
Editing  pop-up menu. If you are modifying an existing recipe, double click on the Compat-
ible Recipes section of the recipe.

☛ In the Recipe Browser, select a recipe and Copy it using the Edit menu.
☛ Return to the Compatible Recipes list and choose Edit:Paste. The compatible recipe’s title

now appears in the list.

If you have several recipes that are compatible with one another, you can Link them together.

☛ From the Recipe Browser, Shift-select the compatible recipes.
☛ Choose Link Recipes from the Recipe menu.

Every recipe you selected is added to the others’ Compatible Recipes list.
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Chapter Four: Finding Recipes

Finding Recipes
If you want Mangia to show only specific kinds of recipes, either in the Browser or the Recipe
File window, you can specify what you want by filling in the blanks in the Quick Recipe Finder
window. Click on the Match What…  button to access the Quick Recipe Finder.

Note that there are several possible fields, but you can fill in as many or as few as you want. If
you fill in several of the items in the Quick Recipe Finder, Mangia shows you only the recipes
that match all the features you specify.

Locating Recipes that Match Several Criteria
To find recipes that match more than one category, for example, all Italian pasta dishes, simply
enter the information into the appropriate fields.

☛ Type pasta  in the Main Ingredient  field, and Italian  in the Nationality  field. Click
OK to return to the Browser.

In the Recipe Browser, you will see only Italian recipes where pasta is the main ingredient, not
Greek pasta recipes or Italian recipes for rice.

You can also specify several things in one field by separating them with a comma.

☛ Type mediterranean, Italian  in the Nationality field to get a list of recipes that fit
both categories: in this case, Neopolitan and Sicilian recipes.

Searching Across Categories
Suppose you want to find recipes that use fresh fruit, but you don’t want to type the name of
every fruit there is.

☛ In the Quick Recipe Finder, click in the Main Ingredient  box. You’ll see the Dictionary
button darken. Click on the Dictionary to open it.



You’ll see there are many items in the fresh fruit category. You don’t want to enter every type of
fresh fruit, as Mangia will look for recipes that contain all the specified ingredients.

☛ Click on the “fresh fruit” category in the Dictionary listings. This will enter “fresh fruit” in
the Main Ingredient  field of the Quick Recipe Finder.

Once you become familiar with the many categories available in Mangia, you can type them in
without having to refer to the Dictionary each time.

Locating Recipes with Specific Notes
The Notes field in a recipe file can contain any text you like. It is the perfect place to make notes
to yourself on how a recipe turned out or if your kids loved it. You can retrieve recipes that have
a particular Note by using the Notes field in the Quick Recipe Finder.

☛ Bring up the Quick Recipe Finder and click the Clear All  button.
☛ Type light  into the Text in the Notes box.
☛ Close the Quick Recipe Finder and return to the Browser. Mangia will list all recipes that

contain the word “light” somewhere in the recipe’s Notes field.

You can do the same with any note you leave in your recipes. For example, you may wish to
suggest wines by name in the Notes field. You can then search for all recipes that go with certain
wines.

Using the Full Recipe Finder
The Full Recipe Finder is a much more powerful version of the Quick Recipe Finder, since it
contains many more search options.

☛ To access the Full Recipe Finder, click on the Full Recipe Finder button in the Quick Recipe
Finder window. This window gives you full control over your recipe searches.
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Searching for an Ingredient Anywhere in a Recipe
In the Full Recipe Finder you can list critical ingredients in one of three fields: Main Ingredients,
Foods to Use and Foods to Avoid.

The difference between Main Ingredients and Foods to Use is important. Most recipes are
dominated by just a few of their ingredients (like the apples in an apple pie), with the other
ingredients playing a more minor role (the butter in the pie crust). When you view or print a
recipe, Mangia denotes the main ingredients in the ingredient list by underlining them. To see
how this work, try the following experiment:

☛ Clear everything out of the Full Recipe Finder, then type eggs  into the Foods to Use field.
☛ Return to the Recipe Browser and choose No Dividers from the Dividers pop-up menu.

You’ll see every recipe that has any egg in it (every cake in the book, for example).

☛ Now, remove eggs  from Foods to Use, and enter eggs  into Main Ingredients.

The Browser will now show you far fewer recipes, like omelets and soufflés.

Avoiding Recipes that Use Certain Foods
This feature is handy if you’re looking for recipes that obey dietary restrictions, allergies or food
preferences.

☛ Type meat  into the Foods to Avoid field and click OK . You will see only meatless recipes.

You can use this feature with generic categories, like “meat”, or specific ingredients, like “corn”.

Locating Recipes According to their Ratings
You can use the Pick Rating feature of the Full Recipe Finder to find recipes according to their
ratings.

☛ Click on the Pick Rating button in the Full Recipe Finder.
☛ Select the Difficulty  item from the pop-up menu. The Dif-

ficulty scale will appear.
☛ Click the mouse near the middle of the scale. The indica-

tor will move to the place you just clicked.

Mangia will now find recipes at only that level of difficulty. However, you may want to see a
range of difficulty levels.

☛ Click and drag on one of the “ears” at each end of the indicator. The indicator will stretch and
show a range along the scale.

The Browser will now show you only the recipes in the Difficulty range you specified.
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Locating Recipes by their Instructions
Like the Quick Recipe Finder, the Full Recipe Finder can find recipes with specific text in the
Title  and Notes, but it also includes a third box to find specific text in the recipe Instructions.

Locating Recipes by Publication and Author
The Publication and Credited Author  text boxes let you find recipes that were published in
specific magazines or books or created by specific people. You can type in the name of the
publication or author or use the pop-up Dictionary  menu to pick from a list.

Locating Timely Recipes
The pop-up menus for Cooking Time in the Full Recipe Finder give you three more options than
the Quick Recipe Finder. As in the Quick Recipe Finder, Elapsed Time lets you specify the total
time from start to finish required to prepare a recipe. In addition:

♦ Prep Time indicates the time you are likely to spend on activities like chopping or peeling
before you actually begin to cook.

♦ Attention Time  indicates the time the cook needs to spend concentrating entirely on the
recipe, including Prep Time.

For example, a casserole might take ten minutes to assemble, but an hour to bake. Its Elapsed
Time would be an hour and ten minutes, but its Attention Time would be only ten minutes.

♦ Finishing Time is the time you need to spend at the last minute before serving. A baked dish
might go straight to the oven from the table, but an omelet is almost entirely finishing time.

Finding recipes with short Finishing Times can be very helpful when you’re planning a dinner
party and want to spend minimal time in the kitchen away from your guests!

Using the Pantry to Cook without Shopping
At the bottom of the Full Recipe Finder is the No Shopping check box. When this box is checked,
Mangia will only list recipes that can be prepared with ingredients currently in your Pantry. Of
course, the No Shopping feature is only useful when your Pantry is up to date. If you don’t have
the desire (or time) to maintain the Pantry inventory with perfect accuracy, Mangia provides a
way to maintain your Pantry while working on your Shopping List. Chapter Five will cover the
Pantry in detail.
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Chapter Five: The Shopping List and the Pantry

This chapter covers two of Mangia’s most useful features: the Shopping List and the Pantry. The
Shopping List allows you to create and edit shopping lists based on selected recipes, and the
Pantry maintains an inventory of ingredients you have in your kitchen.

Creating a Shopping List
Anywhere you see a recipe in Mangia, you can create a Shopping List for it.

☛ If you have a Recipe Card open, click on the Shopping Cart icon to add the recipe to the
Shopping List.

☛ If you are looking at a recipe list, select one or more titles, then click on the Shopping Cart
icon.

☛ Double-click on the Shopping Cart icon to open the Shopping List window.

The Shopping List window shows a list of the ingredients in each recipe you selected. Select and
delete any ingredients you don’t need to buy, then print the list using File:Print .

Editing the Shopping List
After you have generated the Shopping List, you will probably need to make minor adjustments
to eliminate duplicates or items you already have.

☛ To modify an ingredient, double click on it, then make any necessary changes.
☛ To delete an ingredient, select it, then click on the Delete Selected Ingredients button. You

can select several ingredients at once by Shift-clicking on them, or you can select an entire
recipe by clicking on its title.

☛ To add an ingredient to the Shopping List, choose Shopping List:Add Ingredient. Enter
your new ingredient, then click the Add Ingredient button.

Using the Pantry with the Shopping List
When you look at the Shopping List, some of the items are marked with an asterisk (*) to note
that they also appear in your Pantry. If your Pantry is current, you can use this feature to quickly



remove unnecessary items from your Shopping List.

☛ In the Shopping List window, choose Shopping List:Select Ingredients in Pantry to select
the items for deletions.

☛ Click the Delete Selected Ingredients button.

If a recipe gives alternatives (like butter or margarine) and one of them is selected for deletion,
you will probably want to remove the alternatives too.

☛ Click on the Delete Alternative Too button.

Using the Shopping List with the Pantry
You can also use the Shopping List to maintain your Pantry inventory.

☛ Read the items in the Shopping List windows, looking for ingredients
that you do not have. Shift-select each one.

☛ Click on the Remove from Pantry button.

The ingredients are no longer marked, which means that they have been also removed from the
Pantry.

☛ Read the list again, this time Shift-clicking on any unmarked ingredients
you do have.

☛ Click the Add to Pantry button.

If you take a few seconds to update the Pantry whenever you create a Shopping List, Mangia’s
Pantry will more accurately reflect what is in your kitchen.

Printing a Shopping List
Now you’ll need a paper copy of the Shopping List to take to the store with you.

☛ Choose File:Print Shopping List…
☛ If you want the ingredients grouped according to the store section, check Group Ingredients

by Store Section.
☛ If you prefer the ingredients be marked with the recipe name, check Note Recipe for Each

Ingredient.
☛ If you want only the ingredients you’ve selected to print, check Selection Only.
☛ Click the Print  button.
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Chapter Six: Mangia  – Your Culinary Print Shop

You don’t need a computer in your kitchen to use Mangia effectively! Mangia provides you with
many choices of printing options:

♦ Recipes: Print recipes in many different layouts and on a variety of forms, including booklets
and card stock.

♦ Menus: Create “presentation menus” for special occasions or as keepsakes for guests.
♦ Lists: Print shopping lists to take to the store and lists of your recipes and meals.

Printing a Full Page Recipe
Printed recipes are ideal for taking into the kitchen. You can even print a recipe in large type so
you can read it from a distance. And if you spill on it, just print another one, unlike a $50
cookbook!

☛ Open a recipe, then choose Print Recipe Card… from the File menu.
☛ In the resulting dialogue box, click on Page Design and choose your preferred recipe layout.
☛ If the Selection Only checkbox is available, decide whether you want to print all the recipes

in the window or select the recipes you want.
☛ Click the Print button.

Setting up Mangia to Print Booklets and Recipe Cards
When printing items from Mangia, you can choose from several different formats.

♦ Full Page prints your chosen item on one side of a sheet of paper.
♦ ½ Page Booklet and ¼ Page Booklet are used to print menus and recipe booklets.
♦ 4x6 Cardstock and Hand-Fed Cards will print onto pre-cut card stock.

Before you print booklets or recipe cards, you must provide Mangia with some printer informa-
tion. The following steps will help you find the necessary information and show you how to
input it into Mangia.

☛ On a new sheet of paper, write the words “In Up” and draw an arrow pointing to one end of
the paper. Load this sheet of paper into the printer with the writing face up and the arrow
pointing into the printer.

☛ Print a full page recipe.
☛ When the page comes out, write the words “Out Up” on the side of the paper that’s up as it

emerges from the printer.
☛ In Mangia, choose Print Recipes… from the File menu.
☛ Check the Print Two Sides Separately and click the Print  button.
☛ In the resulting Load Paper dialog box, click the Printer Info…  button.



Now tell Mangia the result of your paper experiment:

☛ If the printing is on the same side as the word “In Up”, click the Upside button. Otherwise,
click the Downside button.

☛ If the printing is on the same side as the words “Out Up”, click the Face Up button. Other-
wise, click the Face Down button.

☛ Hold the page so you can read what you printed. If the arrow is pointed toward the top of the
page, click the Head First button. If the arrow is pointing to the bottom, click the Foot First
button.

☛ For hand-fed recipe card stock, look at the guide that feeds narrow pieces of paper (like
envelopes) into your printer. Does it feed them at the left side, right side or center? Click the
appropriate button.

☛ If your printer takes sheets from the bottom instead of the top, click Printer Feeds From
Bottom of Stack box

☛ Click OK to save the printer information. Click Cancel to quit the printing process.

Mangia will save your settings and use them to guide you through the two-sided printing pro-
cess. You won’t need to change these settings again unless you change your printer.

Printing a Menu
If you’ve worked hard on an important dinner party, it’s fun to hand out keepsake menus of the
event.

☛ In the Recipe File window, click on the title of the meal you want to print.
☛ Select Print Menus… from the File menu.
☛ Select your desired menu format from those provided.
☛ Click Print .

To set the font and size of a printed menu’s text, select Preferences… from the Edit menu. Use
the Text of pop-up menu to choose Menus. Then choose the font and size you want to use. Many
office supply stores stock fun or fancy paper ideal for printing menus – be creative!

Printing a Recipe Booklet
Recipe booklets are a fun way to share your special recipes with friends! This process prints a
booklet that can be read from front to back.

☛ Open a recipe file and Shift-select the recipes you want in your booklet.
☛ Choose Print Recipes… from the File menu.
☛ Click on the icon labeled ¼ Page Booklet.
☛ Check the Two-Pass Printing box, then click Print .
☛ You’ll see the Load Paper dialog instructing you to load your printer. Click OK to continue.

Your printer will print the first half of the booklet on one side of the paper. If you’ve set up your
printer correctly, the Reload Paper dialog box will give you explicit instructions for reloading.
(See the section “Setting Up Mangia to Print Booklets and Recipe Cards”.)
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☛ Follow the instructions in the Reload Paper dialog, then click OK .
☛ After the pages are printed the second time, cut the stack in half along the dotted line.
☛ Place the top half of the page and place it on the bottom half. Do not turn or flip it!
☛ Fold the result in half and staple it in the middle.

You can also print ½ page booklets using these steps, however, you will not need to cut the sheets
before folding and stapling.

Printing Recipe Cards onto Card Stock
Printing on card stock is similar to printing booklets, but you might want to practice on plain
paper first. When you’re ready to print actual recipe cards, we recommend Avery Laser Post-
cards, product number 5389, which are available in most office supply stores.

☛ From the Recipe Browser, Shift-select several recipes.
☛ Choose Print Recipes… from the File menu.
☛ Select 4x6 cardstock from the resulting dialog box. Make sure that Two-Pass Printing is

checked. Click Print .
☛ When the first sides are printed, follow the instructions in the Reload Paper dialog box and

click OK .

If you have set up Mangia correctly, any recipe that requires more room than the front of a card
will continue to print on the back of the card. If you haven’t configured Mangia’s printer settings
yet, see the section “Setting Up Mangia to Print Booklets and Recipe Cards”.

Printing Hand-Fed Recipe Cards
Before you attempt this, check your printer’s manual to see if your printer will accept individual
index cards.

☛ From the Recipe Browser, double click on a recipe to open it.
☛ Choose Print Recipe Card… from the File menu.
☛ If the resulting dialog box includes an option for Manual Feed, select it.
☛ Click on Hand-fed Cardstock. Make sure the Two-Pass Printing box is checked, then click

Print .
☛ Following the instructions in your printer’s manual, feed a card into the printer.
☛ In the Load Paper dialog, click the Printer Info…  button. Specify if the card will enter your

printer at the left, right or center. Check your printer’s manual if you’re unsure.
☛ If necessary, the Reload Paper dialog box will prompt you to turn over the card and reinsert

it. Click OK when you’re ready to continue printing.



Chapter Seven: Customizing Mangia

We know that all cooks are different. Fortunately Mangia provides many options to customize
the program to suit your needs and interests.

Adding New Terms to the Dictionary
Mangia makes it easy to add terms to the Dictionary. Suppose you want to add “chocolate milk”
to the list of ingredients in the Dictionary.

☛ Choose Edit Dictionary  from the Edit menu.
☛ Choose the category you are adding to. In this case, Ingredients.
☛ Click in the For the Ingredient field, then click on the highlighted Dictionary  icon.
☛ Highlight Dairy , then choose Milk .
☛ From the Milk  menu, choose New Milk .
☛ In the resulting dialog box, type chocolate milk in the Normal Spelling field.
☛ Click OK  to save your new Ingredient.

You can also add a new Dictionary entry from the recipe editing window.

☛ Click in the Ingredient field, then click on the Dictionary icon.
☛ Highlight Dairy , then choose Milk .
☛ From the Milk  menu, choose New Milk .
☛ In the resulting dialog box, type chocolate milk in the Normal Spelling field.
☛ Click OK  to save your new Ingredient.

Change the Store Section of an Ingredient.
When Mangia prints a shopping list, you can sort the ingredients by store section for your
convenience. However, not all stores have every item in the same section, or you may prefer to
buy flour in the Bulk Food section instead of the Baking Supplies section. Mangia lets you edit
the Dictionary to change the Section in which an ingredient is found.

section.tif

☛ From Edit:Edit Dictionary , choose Ingredients.
☛ Type or select the name of the ingredient you want to change.
☛ Select the new store section from the Found In: pop-up menu.
☛ Click on Do It or OK .

The ingredient you selected will now be found under a different section of the store on your
shopping list.



Creating Your Own Recipe Ratings
When you are entering or modifying a recipe Mangia lets you create your own rating scale!

☛ Click the Pick Rating button and select New Rating Scale.
☛ Type the new scale’s name.
☛ Choose whether the new rating is a check box or sliding scale.
☛ Click on OK  to save your new rating.

Go Directly to the Full Recipe Finder
You can get to the Full Recipe Finder without going through the Quick Recipe Finder’s Full
Recipe Finder button.

In the Recipe Browser, hold down the Ctrl key (in Windows) or the Option key (on the Macintosh)
when clicking on the Match What… button.

If you prefer that Mangia always use the Full Recipe Finder instead of the Quick Recipe Finder,
select Edit:Preferences, and check the Use Full Recipe Finder box.

Adjust Recipe Scaling
When Mangia scales recipes, it usually adjusts the ingredient amounts to avoid awkward frac-
tions. Mangia gives you three level of scaling; each level has a different effect on your scaled
ingredients.

☛ From the Edit menu, choose Preferences.

When you choose Loose, Mangia will adjust the scaled amount up to 10% to give you a standard
fraction like “3/4 cup milk”. When you choose Medium, Mangia will only adjust the fraction
within 5%, and Tight  keeps the scaled amounts to within 3%. The tighter the scaling, the more
likely you are to see odd ingredient amounts like “7/62 cups of flour”. Usually Loose or Me-
dium scaling will suffice, but for delicate or complex recipes (like a soufflé) or certain ingredi-
ents (like cayenne pepper), you may want to use Tight  scaling.

Change the Fonts in Lists
You can use your favorite fonts in Mangia’s recipe and ingredient lists.

☛ Choose Preferences… from the Edit  menu.

Use the pop-up menus to select fonts and type size.
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Changing the Dividers on the Browser
Editing the divider list allows you to make the dividers as specific or as general as you like. For
example, if you are interested in Chinese cuisine, you may want to add dividers for “Szechuan”
or “Cantonese”.

☛ In the Recipe Browser, use the divider pop-up menu to select the category you want to change.
In this example, we are modifying the “Courses” category.

☛ Click on the pop-up menu again and select Edit Course Dividers.

The resulting dialog box lists the current dividers in the order they appear.

In this window you can:

☛ Reorder the list by clicking and dragging course name. The dividers will appear in the Browser
in the same order as they appear in the list.

☛ To remove any category you don’t want, Highlight an entry, then press Delete or select
Edit:Clear .

☛ Create new dividers by typing a new category into the New Divider Box, or use the Dictio-
nary button to select a new divider. Click the >>Add to List>> button, then click OK .

Chapter Seven: Customizing Mangia 25



Chapter Eight: Contacting Sierra On-Line

Contacting  Sierra’s Technical Support
Contact Technical Support if you have any problem with the installation of Mangia or if you
experience difficulties with the program. Please note: Before contacting Sierra Technical
Support about printing problems, please contact your printer manufacturer for the latest
drivers.

Sierra Technical Support
Voice Line: 206-644-4343
Fax Line: 206-644-7697
Automated Tech Support System: 206-644-4343
Mail: Sierra On-Line Technical Support

PO Box 85006
Bellevue, WA  98015-8506

Sierra Technical Support E-Mail
America On-Line Keyword: Sierra
CompuServe GO Sierra
Sierra Internet Website http://www.sierra.com
Internet Mail support@sierra.com

Technical Support – United Kingdom
Voice Line: (0118) 920-9111
Fax Line: (0118) 987-5603
Mail: Sierra On-Line Limited

2 Beacontree Plaza
Gillette Way
Reading
RG2 OBS UNITED KINGDOM

Technical Support – France
Voice Line: (33) 1-46-01-46-50
Fax Line: (33) 1-46-30-00-65
Mail: Parc Tertiaire de Meudon

Immeuble “Le Newton”
25 rue Jeanne Braconnier
92366 Meudon La Forêt Cedex FRANCE

Technical Support – Germany
Voice Line: (+49) 0-6103-99-40-40
Fax Line: (+49) 0-6103-99-40-35
Mailbox: (+49) 0-6103-99-40-41
Mail: Sierra Coktel Deutschland

Robert-Bosch-Str. 32
D-63303 Dreieich GERMANY



Servicio Tecnico – Spain
Voice Line: (34) 1-764-39-69
Fax Line: (34) 1-382-08-39
Mail: Coktel Educative Multimedia

C/Tomas Redondo, 1-1° F
Edificio Luarca
28033 Madrid SPAIN

Sierra Direct Sales Group
Our Direct Sales personnel are here to help you with problems concerning disk or
documentation replacement, upgrades, or purchasing any other Sierra products.

Voice Line: 800-757-7707
Fax Line 402-393-3224
Mail: Sierra Direct Sales

7100 West Center Road
Suite 301
Omaha, NE  68106

Disk or Documentation Replacement
Sierra will replace defective disks and documentation for the first 90 days of ownership free of
charge. After 90 days all requests are subject to shipping and handling fees.

♦ Disk replacement: All requests within the warranty period must include a copy of your sales
receipt and the CD. Include a note telling us why you need a disk replacement and where to
send it. If you are outside the 90-day warranty period, please include $10 to cover shipping
and handling.

♦ Documentation replacement: Requests within the warranty period must include a copy of
your sales receipt, a photocopy of the CD (please do not send the CD), a note telling us why
the documentation is being replaced, and a shipping address. Requests past the 90-day war-
ranty period, please include $5 to cover shipping and handling.

Send all requests for disk or documentation replacement to:
Sierra On-Line Fulfillment
PO Box 485
Coarsegold, CA  93614
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IT IS ILLEGAL TO MAKE UNAUTHORIZED COPIES OF THIS SOFTWARE
This software is protected under federal copyright law. It is illegal to make or distribute copies of this
software except to make a backup copy for archival purposes only. Duplication of this software for any
other reason including for sale, loan, rental or gift is a federal crime. Penalties include fines as high as
$50,000 and jail terms of up to five years.

Sierra On-Line, Inc. supports the industry’s effort to fight the illegal copying of personal computer software.
Report Copyright Violations To: SPA, 1730 M Street NW, Suite 700, Washington, DC, 20036, (202) 452-
1600.

This manual, and the software described in this manual are copyrighted. All rights are reserved. No part of
this manual or the described software may be copied, reproduced, translated or reduced to any electronic
medium or machine-readable form without the prior written consent of Sierra On-Line, Inc. © 1997 Sierra
On-Line, Inc. ® and / or TM designate trademarks of, or licensed to Sierra On-Line, Inc. All rights reserved.
Bellevue, WA 98007. Printed in the USA.

LIMITATIONS ON WARRANTY
UNATHORIZED PRESPRESENTATIONS: SIERRA WARRANTS ONLY THAT THE PROGRAM WILL
PERFORM AS DESCRIBED IN THE USER DOCUMENTATION. NO OTHER ADVERTISING,
DESCRIPTION, OR REPRESENTATION, WHETHER MADE BY A SIERRA DEALER, DISTRIBUTOR,
AGENT, OR EMPLOYEE, SHALL BE BINDING UPON SIERRA OR SHALL CHANGE THE TERMS
OF THIS WARRANTY.

IMPLIED WARRANTIES LIMITED: EXCEPT AS STATED ABOVE, SIERRA MAKES NO WARRANTY,
EXPRESS OR IMPLIED, REGARDING THIS PRODUCT. SIERRA DISCLAIMS ANY WARRANTY
THAT THE SOFTWARE IS FIT FOR A PARTICULAR PURPOSE, AND ANY IMPLIED WARRANTY
OF MERCHANTABILITY SHALL BE LIMITED TO THE NINETY (90) DAY DURATION OF THIS
LIMITED EXPRESS WARRANTY AND IS OTHERWISE EXPRESSLY AND SPECIFICALLY
DISCLAIMED. SOME STATES DO NOT ALLOW LIMITATION ON HOW LONG AN IMPLIED
WARRANTY LASTS, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

NO CONSEQUENTIAL DAMAGES: SIERRA SHALL NOT BE LIABLE FOR SPECIAL, INCIDENTAL,
CONSEQUENTIAL OR OTHER DAMAGES, EVEN IF SIERRA IS ADVISED OF OR AWARE OF THE
POSSIBILITY OF SUCH DAMAGES. THIS MEANS THAT SIERRA SHALL NOT BE RESPONSIBLE
OR LIABLE FOR LOST PROFIT OR REVENUES, OR FOR DAMAGES OR COSTS INCURRED AS A
RESULT OF LOSS OF TIME, DATA OR USE OF THE SOFTWARE, OR FROM ANY OTHER CAUSE
EXCEPT THE ACTUAL COST OF THE PRODUCT. IN NO EVENT SHALL SIERRA’S LIABILITY
EXCEED THE PURCHASE PRICE OF THIS PRODUCT. SOME STATES DO NOT ALLOW THE
EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSQUENTIAL DAMAGES, SO THE ABOVE
LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

YOU ARE ENTITLED TO USE THIS PRODUCT FOR YOUR OWN USE, BUT MAY NOT SELL OR
TRANSFER REPRODUCTIONS OF THE SOFTWARE, MANUAL, OR BOOK TO OTHER PARTES IN
ANY WAY, NOR RENT OR LEASE THE PRODUCT TO OTHERS WITHOUT PRIOR WRITTEN
PERMISSION OF SIERRA. YOU MAY USE ONE COPY OF THE PRODUCT ON A SINGLE GAME
MACHINE, COMPUTER OR COMPUTER TERMINAL. YOU MAY NOT NETWORK THE PRODUCT
OR OTHERWISE INSTALL IT OR USE IT ON MORE THAN ONE GAME MACHINE, COMPUTER,
OR COMPUTER TERMINAL AT THE SAME TIME.
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